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Welcome to Wizcon for Internet, a Supervisory Control and Data
Acquisition (SCADA) application development tool that enables system
integrators to create sophisticated Supervisory and Control applications for
a wide variety of industries.

Wizcon for Internet allows you to integrate your application with your
Internet/Intranet network, promoting real-time Supervisory and Control
using real-time graphics and event-driven information updates from any
computing platform.

Wizcon for Internet applications can be accessed and used without
requiring platform-specific software, client software installation, or plug-
ins.

In this guide, we will show you a working application of a plant. You will
interact with the application and familiarize yourself with Wizcon for
Internet. Then, we will step you through a tutorial in which you will
complete an unfinished version of the same application.

 The workflow for this Getting Started guide is as follows :

■ Install Wizcon for Internet, as described on page 4.

■ Open a completed application that we have named Final Application
(Final Exercise), as described on page 9.

■ Interact with the application through your browser, as described on
page 11.

■ Build an application by opening and completing the Exercise
Application, (Tutor Exercise) an unfinished version of the Final
Application, as described on page 20.
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,QVWDOOLQJ�:L]FRQ�IRU
,QWHUQHW

This section first describes the Wizcon for Internet system requirements
and then the instructions for installing Wizcon for Internet on your
computer.

6\VWHP�5HTXLUHPHQWV

Before you install Wizcon for Internet, verify that you have the following:

+DUGZDUH

Computer: 200 MHz Pentium, or higher.

Memory: 64 MB minimum.

Hard Disk: 120 MB minimum free.

Display: VGA, SVGA, or any graphic adaptor that supports the operating
system desktop. The display should be set at 256 colors or higher and the
screen resolution should be set at 640 x 480 or higher.

Mouse: Any Windows compatible mouse.

Parallel Port: Required for the Wizcon for Internet security plug.

You may need add-on adaptors, such as network controllers, for specific
installations.
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6RIWZDUH

Operating System: Microsoft’s Windows NT version 4.0 (or higher).
Microsoft’s Windows 95, 98 can be used for application development.

■ Properly configured TCP/IP: A fixed IP address is required for a web
server. Or Windows 95,98 NetBEUI Protocol.

■ Web server: A web server is required for publishing the application,
(not for development). For example the Netscape FastTrack Server
2.1 that can be downloaded from the Netscape web site at
http://www.netscape.com), or the Microsoft Internet Information
Server that can be downloaded from the Microsoft web site.

■ Browser: A Java 1.1-enabled browser is required. Netscape
Communicator 4.0 or higher, or Microsoft Internet Explorer 4.1.

■ HTML Editor: Any HTML editor may be used.

Note: If your browser does not include an HTML editor, a text editor such
as Notepad may be used instead. See Appendix A in this guide, for details
on how to make Notepad your default HTML editor.
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,QVWDOODWLRQ

It is strongly recommended that you close and exit all Windows programs
before running the setup.

➤ To install Wizcon:

1. Insert the CD-ROM into the CD drive, Windows automatically loads
and runs the Setup program. The CD-ROM has an Autorun Setup
program. The WizFactory Setup program is displayed:

 Or

 If your Windows is not configured for Autorun you will need to run the
Master Setup yourself. Click on the Start button, select Run and enter:
D:\setup.exe into the Open field (where D is your CD-ROM
drive). Click OK.
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2. Select Wizcon for Windows and Internet from the WizFactory Setup
CD to load the setup program for Wizcon. The following dialog is
displayed:

 

3. Click on the Next button to continue the installation. The following
dialog is displayed in which you can choose the directory in which
Wizcon for Internet will be installed:
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4. If you have a previous version of Wizcon installed, you are prompted to
overwrite the previous version or to Exit the installation, in the
following note:

 

 It is recommended to click Yes to overwrite the previous installation.

5. Click the Next button to install Wizcon in the default folder:
(C:\WizFactory\Wizcon). Click the Browse button if you want to
change the default directory.

6. Click the Next button and the Select Components dialog is displayed:

 

In this dialog, you can select the following components for installation:
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System Files: Select this option to install the Wizcon for Windows and
Internet application files in the directory specified in the Destination
Directory field in this dialog. The default directory is
C:\WizFactory\Wizcon.

Communication Drivers (Optional): Select this option if you are using
an external driver or controller. You can then select the drivers you
want to install from a list of existing Wizcon device drivers. Press the
Change button to open another dialog where you select the drivers you
wish to install.
The dialog specifies the default directory in which Wizcon will be
installed.

Getting Started - Web: Select this option to install the Wizcon for
Internet Getting Started tutorials (Exercise and Final applications).

Getting Started - Windows: Select this option to install the Wizcon for
Windows Getting Started tutorials (Exercise and Final applications).

It is recommended to select the Wizcon System files option. Click the
Next button. The Select a Language dialog is displayed:
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Please note that you will not receive the Select Language dialog if you
did not Check (á) the System files.

7. Choose one of the languages that you want to install. Wizcon is
localized for English, French, German, Chinese, Japanese, and Polish.

8. Press the Next button. A progress bar is displayed and the installation
begins. When installation is complete the Finish Reboot dialog is
displayed. Click Yes to restart your PC or click No to update later. It is
recommended to restart your PC immediately after installation.

 

9. Click Finish. Installation is complete.

1RZ�\RX�ZLOO�RSHQ�D�ZRUNLQJ�DSSOLFDWLRQ��FDOOHG�)LQDO�$SSOLFDWLRQ��)LQDO
([HUFLVH���2Q�SDJH�����\RX�ZLOO�VWDUW�LQWHUDFWLQJ�ZLWK�LW�
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,QWHUDFWLQJ�ZLWK�D
:RUNLQJ�$SSOLFDWLRQ

In this section you will interact with a working application so that you can
familiarize yourself with Wizcon for Internet. This involves the following
steps:

■ Opening the Final Application (Final Exercise), as described below.

■ Interacting with the Final Application through your browser, as
described on page 11.

2SHQLQJ�WKH�)LQDO�$SSOLFDWLRQ

When you open the Final Application, the Wizcon Quick Access bar,
shown below, is displayed in which you can quickly access different parts
of the application. In this Getting Started guide you will use the Wizcon
Quick Access bar to open the Wizcon Application Studio, which is the
operational framework of Wizcon for Windows and Internet, and to exit
Wizcon.

➤ To open the Final Application:

1. Click the Start button and then point to Programs. From the displayed
menu, point to WizFactory, point to Wizcon, and then Getting
Started for the Web. From the displayed menu, click on Final
Application (Final Exercise).
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2. The Wizcon Quick Access bar is displayed in the top left corner of your
desktop.

 

3. Click on the Wizcon Application Studio  button. The Wizcon for
Windows and Internet Application Studio is displayed together with the
Tip of the Day window.

 

 You can click, deselect Show Tips on Startup if you do not want to
display the Tip of the Day window when you next open Wizcon, or
click Next Tip to display another tip.

4. Click Close to close the window. The Wizcon Application Studio
remains displayed. It is described in detail on page 22.

1RZ�\RX�ZLOO�RSHQ�WKH�DSSOLFDWLRQ�LPDJH�DQG�LQWHUDFW�ZLWK�LW�WKURXJK
\RXU�EURZVHU�
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,QWHUDFWLQJ�ZLWK�WKH�$SSOLFDWLRQ

In this step you will interact with the application through your browser.
You will open the application Welcome page which contains two links:

• A link that displays a graphical representation of the application
process.

• A link that displays online alarms.

This will involve the following steps:

■ Opening the application welcome page, as described below.

■ Displaying the graphical representation of the application process, as
described on page 13.

■ Displaying online alarms, as described on page 17.

2SHQLQJ�WKH�$SSOLFDWLRQ�:HOFRPH�3DJH

The application Welcome page is opened in your default browser through
the Wizcon Application Studio.

1RUPDOO\�WKH�RSHUDWRU�ZLOO�RSHQ�DQ�DSSOLFDWLRQ�E\�HQWHULQJ�WKH
DSSOLFDWLRQ�:HE�VLWH�85/��DGGUHVV��LQ�WKH�EURZVHU��,Q�WKLV�*HWWLQJ
6WDUWHG�DSSOLFDWLRQ��WKLV�PHWKRG�LV�QRW�DYDLODEOH�DV�WKHUH�LV�QR
VHUYHU�LQVWDOOHG�
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➤ To open the application welcome page:

In the All Containers section on the left side of the Wizcon for Internet
Application Studio, click HTML. A list of HTML files is displayed in the
section on the right side of the Wizcon for Internet Application Studio.

In the List of HTML files section, double-click welcome.htm to launch
the welcome page in your default browser. The following page is displayed:

There are two clickable links:

■ Go to Plant Floor View, which displays a picture of the plant floor
view, as described on the following page.

■ Go to Online Alarms View, which displays online alarms, as
described on page 17.
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*R�WR�3ODQW�)ORRU�9LHZ

Wizcon for Internet enables process monitoring through various visual
options. One of the most interesting of these is the Wizcon for Internet
Picture Viewer that displays a graphical representation of the application
process. This picture was created in the Wizcon for Internet authoring
environment using the Wizcon for Internet Image Editor.

In this section you will display this picture in your browser and interact
with it to see some of the interesting features of a completed application.

➤ To display the graphical representation of the application:

Click on the Go to Plant Floor View link in the welcome page, as shown
on the previous page. The browser displays the following:
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Let’s take a look at the objects in this picture:

A storage tank that contains raw material.

A pump and a valve that control the raw material output from the
storage tank to the reactor.

A reactor to which the raw material from the storage tank is
pumped. It is then mixed and heated to a specified temperature.

A valve that controls the output from the reactor to the output
tank.

An output tank to which the mixed material is discharged from
the reactor.

A truck into which the mixed material is loaded at the end of the
process.

A button which can be pressed to display only the part of the
image that represents the input process.

Notice the text displays next to the storage tank and the reactor representing
the quantity of the material inside them.

These displays are dynamic, meaning that while the application is running,
their displayed value changes according to the actual quantity of material in
the storage tank and in the reactor.
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Notice the text displays next to the pump, the Valve_In and the Valve_Out.

These too are dynamic displays that represent the run/stop status of the
pump and the open/close status of the valves.

<RX�ZLOO�QRZ�LQWHUDFW�ZLWK�WKH�SLFWXUH�WR�VHH�KRZ�WKH�SODQW�SURFHVV
FDQ�EH�PRQLWRUHG�DQG�FRQWUROOHG�

Click on the pump. Notice how its red button changes to green and
how its text display reads Run.

 Click on the Valve_In. Notice how its handle turns from red to green
and swivels from right to left and how its text display reads Open.
The storage tank then starts emptying its raw material and the reactor
starts to fill. The material is mixed in the reactor.

 Click on the Valve_Out in order to empty the reactor of the material.
Notice how its handle turns from red to green and that its text display
reads Open. The Tank_Out fills and the storage tank continues to
empty.

When the Tank_Out is full, the Valve_Out closes. Notice how its
handle changes from green to red.

 Click on the truck to empty the Tank_Out. The material pours out of
the Tank_Out and into the truck. When the Tank_Out is completely
empty the truck moves to its destination on the other side of the
image.

When the truck reaches its destination, it returns to its starting point.
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Wizcon for Internet enables you to section off parts of an image when
editing, and then zoom in (view) one particular part. Each time you
save the image, a single picture file is created for each zone
containing the zone’s graphic objects. This picture is displayed by the
Picture Viewer your browser when you access the zone.

Click on the button on the bottom left side of the image to display the
Input zone, as shown below.

The input process part of the plant is displayed.

Click on the Overview Zone button to redisplay the entire plant floor view.
Click the Back button in your browser to return to the Welcome page.

<RX�ZLOO�QRZ�YLHZ�WKH�RQOLQH�DODUPV�LQIRUPDWLRQ�
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*R�WR�2QOLQH�$ODUPV�9LHZ

Wizcon for Internet can alert you of exceptional conditions in the plant,
such as overheating in the reactor, in the form of online alarms.

The alarms are displayed in the Events Summary, which is a Java applet
that displays online alarms and enables users to acknowledge them.

The layout of the Events Summary (its columns, contents and button
options) are determined by the definitions in the Events Summary Profile.
You will learn how to define an Events Summary Profile in Step 9 on page
75.

➤ To display the online alarms:

Click the Go to Online Alarms View link in the Welcome page. The
Online Alarms page is displayed.
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The following columns are available in this Events Summary:

Start time: the time the alarm was generated

Ack time: the time the alarm was acknowledged by the operator

End time: the time the alarm was terminated

Severity: the severity of the alarm

Text: the alarm message

Family: the name assigned to a specified group of alarms.

The alarm Severity, Text and Family details were defined when the alarm
was defined.

:H�KDYH�ILQLVKHG�ORRNLQJ�DW�WKLV�DSSOLFDWLRQ��/HW·V�FORVH�LW�
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&ORVLQJ�WKH�$SSOLFDWLRQ

You have interacted with a sample Wizcon for Internet application. You are
now going to close this application. In the next step you will open the
unfinished version of this application, and throughout the remainder of the
tutorial complete it to achieve this final result.

➤ To close the application:

1. From the browser File menu, select Exit. The browser closes and the
Wizcon for Internet Quick Access bar is displayed.

2. Click on the Close  button in its top right corner. Wizcon closes.

<RX�ZLOO�QRZ�EXLOG�DQ�DSSOLFDWLRQ�E\�RSHQLQJ�DQ�XQILQLVKHG�YHUVLRQ�RI
WKLV�DSSOLFDWLRQ�DQG�FRPSOHWLQJ�LW�DV�GHVFULEHG�LQ�WKH�IROORZLQJ�SDJHV�
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%XLOGLQJ�$Q�$SSOLFDWLRQ

In this section you will build a Wizcon for Internet application. You will
open the Exercise Application, which is an unfinished version of the Final
Application presented to you on pages 11 through 18, and perform the
steps required to complete it, as follows:

■ Opening the Exercise Application (Tutor Exercise), as described
below.

■ Viewing the Wizcon for Internet Application Studio, as described on
page 22.

■ Opening the application image and adjusting it, as described on
page 24.

■ Following Steps 1 through 10, as described on page 32, to complete this
application.

■ Publish the Exercise Application on the Internet or your Intranet, as
described on page 84.

2SHQLQJ�WKH�([HUFLVH�$SSOLFDWLRQ

You will now open the Exercise Application, upon which this tutorial is
based.

➤ To open the application:

1. Click the Start button and then point to Programs. From the displayed
menu, point to WizFactory, point to Wizcon and then to Getting
Started for the Web. From the displayed menu, click on Exercise
Application (Tutor Exercise). The Wizcon Quick Access Bar is
displayed:
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2. Click the Wizcon Application Studio  button. The Wizcon
Application Studio is displayed together with the Tip of the Day
window, as shown on page 10.

3. Click Close to close the Tip of the Day window. The Wizcon
Application Studio remains displayed, as shown on the following page.

7KH�:L]FRQ�$SSOLFDWLRQ�6WXGLR� �EXWWRQ�LV�D�WRJJOH�EXWWRQ��<RX�FDQ
FOLFN�LW�WR�FORVH�WKH�:L]FRQ�$SSOLFDWLRQ�6WXGLR�DQG�WKHQ�FOLFN�LW�DJDLQ
WR�GLVSOD\�WKH�:L]FRQ�$SSOLFDWLRQ�6WXGLR�
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9LHZLQJ�WKH�:L]FRQ�IRU�,QWHUQHW�$SSOLFDWLRQ�6WXGLR

The Wizcon Application Studio is displayed, as shown below. It is used to
create a Wizcon for Internet application.

It is divided into two frames:

■ All Containers tree on the left: displays a hierarchical structure of the
containers from which you build a Wizcon for Internet application.
Containers can be thought of as the building blocks of a Wizcon for
Internet application. The tree is made up of three main groups: Web
Application, Files, and Objects.

Control Panel on the right: from which you change the settings of the
application, such as printer settings and user setups, and activate
utilities like Single Tag. The Control Panel is displayed when the initial
container is selected, in this case GettingStartedTutor which is the
file name of this application.
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The Control Panel displays icons that represent elements of Wizcon for
Internet that do not appear in the All Containers tree.

When a container is selected in the All Containers section on the left, a
list of its contents is displayed on the right. For example when Alarms
is selected in the All Containers list, a list of all the alarms in the
application is displayed in the List of Alarms, as shown below.

The Wizcon for Internet Application Studio also contains:

 A menu bar through which you can access Wizcon for Internet
operational menus.

 A toolbar that enables quick access to Wizcon for Internet Application
Studio most frequently used functions.

Now you will open the application image.
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  Viewing the Application Image

In this section you will open the application image. When the image is
opened it may not be adjusted in its window due to screen resolution which
differs from computer to computer. The image is displayed in a window
which you will resize. Then you will reposition the image within its
window. This involves the following steps:

 Opening the image, as described below.

 Resizing the image window, as described on page 26.

 Repositioning the image within its window, as described on page 27.

 Saving these changes, as described on page 28.

Opening the Image

You will now open the application image.

! To open the image:

1. In the All Containers section of the Wizcon Application Studio, click
on Images. The section on the right side of the Wizcon Application
Studio changes from the Control Panel to a List of Images.

2. In the List of Images section, double-click MY_FIRST.
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The application image and its Drawing toolbox are displayed. Screen
resolution differs from computer to computer, therefore your image
may not be displayed exactly as shown below:

If image is larger than the default window size that opens, you may resize
the image window. Afterward you can reposition the image within the
window, as described on the following pages.
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Resizing the Image Window

If needed you can now resize the image window so that it fills the entire
desktop.

! To adjust the image window:

Grab the right hand corner of the image window and drag slowly until the
window fills the entire desktop.

You may need to move the image up to the top of your desktop by
holding down the left mouse button on its title bar and repositioning.

The image should resemble the one shown below:

The Drawing toolbox can be repositioned by holding down the left
mouse button on its title bar and moving it to a different position.
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Adjusting the Image within its W indow

The image is now partially displayed in a larger window. You can
reposition the image within its window so that the entire image is displayed.

! Adjusting the image within its window:

1. Click the scroll bar arrows. Each click will reposition the image a little.

Note: Clicking the scroll bar may adjust the position of the image by too
large an increment and the image may no longer be displayed or will
distort.

2. Fine-tune the positioning by selecting Goto from the Options menu of
the image. The Goto dialog is displayed:

 

3. In the Position area, increase or decrease the X and Y positions as
necessary by increments of up to 200 and click OK. The image will be
repositioned by the specified increment. Repeat as required.
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The image should now resemble the one shown below:

Saving the Image

Now you will save your settings so that the next time you open the image it
will be displayed with these settings, as shown above.

! To save the image:

From the image File menu, select Save.

Let’s now compare this image to the image we viewed on page 13.
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Notice that the following objects are missing:

The reactor

The output tank

The truck

The piping

button

The text display for the reactor

The text display for the Valve_Out.

Some of the application building blocks, are also missing and therefore you
cannot interact with the application.
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Tutorial W orkflow

Let’s now take a look at the workflow of the tutorial that you will complete
so that this unfinished application will resemble the finished application
described on pages 10 through 17.

! This tutorial is divided into the following steps:

Step 1: Defining a Tag, page 32, defines a tag, which is an internal
variable, to indicate the truck’s movement.

Step 2: Defining an Alarm, page 36, defines an alarm that will display
when the level of material in the storage tank is too low.

Step 3: Building the Application Image, page 38, completes the image by:

 Inserting the parts of the application that are missing in the image from
the clusters library:

•  The reactor

•  The output tank

•  The truck

 Drawing the piping that connects the objects.

Step 4: Creating Dynamic Text Displays, page47, creates dynamic text
displays to indicate the level of material in the reactor and the on/off status
of the Valve_Out.

Step 5: Making an Object Dynamic, page 52, defines dynamics for the
truck to make it move when it has filled with material from the storage tank.

Step 6: Defining Zones, page 58, defines two zones in the image: the
Overview zone in which the entire image is displayed, and the Input zone in
which only the part of the image that represents the input process is
displayed.
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Step 7: Creating Trigger Buttons, page 64, creates two buttons, called
triggers: one that can be clicked to display a zoomed section of the image
and the other that can be clicked to display the entire image.

Step 8: Generating HTML Files, page 70, describes generating HTML files
for the Include Picture Viewer and the Events Summary and generates an
HTML file for the Include Picture Viewer.

Step 9: Defining an Events Summary Profile, page 75, defines an Events
Summary Profile to determine how alarm information is displayed.

Step 10: Generating an HTML file for the Events Summary, page 78,
generates an HTML page for the Events Summary.

Step 11: Testing Your Application in a Local Browser, page 83,
describes how to test your application in a local browser.

Step 12: Publishing Your Application, page 84, describes how to publish
your application on a Web server.

Step 13: Exiting Wizcon for Internet, page 90, describes how to exit
Wizcon for Internet.
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Step 1: Defining a Tag

A Wizcon for Internet tag is used as an internal variable for:

 Calculations and display.

 Communication with PLCs (Programmable Language Controllers) in
order to represent data from PLC memory or to send commands to
PLCs.

There are three types of tags: PLC, Dummy, and Compound:

PLC: A PLC tag represents data from a PLC memory. Each PLC tag is
associated with a specific PLC register, defined as Tag address in Wizcon
for Internet's tag definition. The format of a tag address varies from one
PLC to another and depends on the PLC memory structure, internal
architecture and communication protocol. When exchanging data between
Wizcon tags and PLCs, the communication driver for the specific PLC
should be installed.

Dummy: A dummy tag represents internal variables that are not connected
to the field devices. Dummy tags are used for various calculations or
internal processing. We will use a dummy tag in our tutorial.

Compound: A compound tag is a tag whose value is calculated from a
linear combination of the two other tags.

PLC and Dummy tags can be one of the following types:

 Analog: that represent numeric values, such as integers, longs and
floats.

 Digital: that represent discrete logic states.

 String: that represent textual data.
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In this Getting Started application, a communication driver has been
installed that simulates input to and output from the field devices, such as
the storage tank and truck.

You will now define a tag to indicate the truck’s movement.

Defining a Tag for the Truck

You will now define a dummy tag that will be used to indicate the truck’s
movement. This is done in the Wizcon for Internet Application Studio.

! To define a tag:

1. Minimize the image by clicking the Minimize  button in its top right
corner in order to get a clear view of the Wizcon Application Studio
and the dialogs in which you will define the tag.

2. Click the Application Studio  button in the task bar at the
bottom of your screen. The Wizcon Application Studio is displayed, as
shown on page 10.

3. From the All Containers section of the Application Studio, right-click
Tags and select Add Tag from the displayed pop-up menu.
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The Tag Definition: New Tag dialog is displayed:

 

4. In the Tag Name field enter MOVE_TRUCK.

5. In the Description field enter Truck Movement.

6. Click OK to confirm your definitions of the tag and to close the dialog.

We have now defined a tag called MOVE_TRUCK that indicates the
truck’s movement. Default options determine that the tags source is a
dummy, meaning that the tag will be used for internal processing only.
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Did You Know
 Up to 16 communication drivers can be installed on one Wizcon

for Internet station.

 Each driver can be connected with up to 256 PLCs (Programmable
Language Controllers) on a network.

 Each communication driver runs under a dedicated Windows NT,
95 or 98 thread.

 All drivers communicate simultaneously with PLCs and external
devices.

 The total number of tags that can be defined in the maximum
model of Wizcon for Internet is 65,000. In this Getting Started
application the maximum number of tags that can be defined is
ten.

In the next step you will define an alarm that will be displayed if the
level of raw material in the storage tank is too low.
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Step 2: Defining an Alarm

Wizcon for Internet alarms are application messages that notify operators
about exceptional conditions in the plant. They provide operators with
information concerning internal system events, such as communication
driver failure, network communication errors and so on.

Wizcon for Internet alarms are displayed in an Events Summary during run-
time.

In this section you will define an alarm that will be displayed if the level of
the raw material in the storage tank is too low.

! To define an alarm:

1. From the All Containers section of the Wizcon Application Studio,
right-click Alarms and select Add Alarm. The Alarm Definition: New
Alarm dialog is displayed:
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2. Click on the arrow to the right of the Tag Name field and select
STORAGE from the drop-down list.

3. Click on the arrow to the right of the Operator field and select <=.

4. In the Value field, enter 200.

5. In the Alarm Text field, enter Level in Storage is Low. This
is the message that will appear when the alarm is displayed.

6. In the Family field, enter Tanks. This is the group of alarms to which
the alarm will belong.

7. In the Severity field, enter 7.

8. In the Targets area, check Events Summary. The alarm will be viewed
in an Events Summary.

9. Click OK to save your definitions and to close the dialog.

You have defined the tags and alarms for your application. In the
next step you will build the application image.
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 Step 3: Building the Application Image

Now that you have defined tags and alarms for the application, you will use
the Wizcon for Internet Image Editor to build the application image.

In order for the Exercise Application image to resemble the Final
Application image, you need to add the reactor, the output tank, the truck,
the piping, and the Overview and Input buttons.

Exercise Application Image Final Application Image

This step is made up of two parts:

 Using the Wizcon for Internet clusters library to insert objects with pre-
defined behavior patterns, as described below.

 Using Wizcon for Internet drawing tools to draw the piping, as
described on page 44.
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The Clusters Library

The Wizcon clusters library uses object oriented technology to simplify and
speed up application design and maintenance. A cluster is an object-class
with pre-defined behavior patterns that may include the following:

 The graphical shape of the object.

 Tag definition.

 Dynamics, meaning how the object is animated. It may move, change
color, fill and empty, and so on.

 Triggers for user interaction. For example, clicking on a trigger-defined
object can change a tag value.

Clusters can be placed in an application and used as needed. They can be
simple (such as circles or pumps), or complex (such as a small application
that includes, tanks, pumps and valves). Working with clusters is much
easier than working with graphic elements separately.

Wizcon comes with a rich set of cluster libraries that include a variety of
pre-built objects, such as control buttons, valves, pumps and other industry
standard components. We have developed a cluster library called FirstLib,
that contains the objects needed for this Getting Started application.

Once you place a cluster in your application, you create a single instance of
that object. Each cluster can have many different instances, each with the
specific characteristics, or properties, that you define according to your
application’s needs. For example, each instance can be associated with a
different set of tags and alarms that you define when creating a new
instance in the application. The action of creating a separate instance of the
object or function is called Instantiation.
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In this section you will insert the reactor, the output tank and the truck from
the clusters library into the image. This involves the following steps:

 Accessing the unfinished image, as described below.

 Inserting objects from the clusters library, as described below.

 Repositioning the objects in the image.

Accessing the Image

You will now access the image so that afterward you can insert objects
from the clusters library.

! To access the unfinished image:

Click the MY_FIRST  button in the task bar at the bottom of your
screen to display the image.

Inserting Objects from the Clusters Library

You will now open the clusters library and insert the following objects from
the clusters library into the image:

 The reactor

 The output tank

 The truck

After you have inserted the objects, you will move them to their correct
position.

You may find it helpful to display the drawing grid before you begin
inserting objects, by selecting Grid Show from the Modes menu.
Objects that are inserted before displaying the Grid will not snap
to.
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! To insert objects from the clusters library:

1. From the Clusters menu of the image select Open lib. The following
dialog is displayed:

 

2. Click on the drop-down box and select FIRSTLIB. This is the library
that contains the objects used in this Getting Started application.
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3. Left-click on the reactor, drag it out of the library dialog and drop it on
to the image. The Define Instance Link dialog is displayed:

 

 Notice the list of pre-defined dynamics that appear in the Linked Tags
and Alarms field.

4. In the Instance Name field enter Reactor and click OK to save your
settings and to close the dialog. The reactor now appears in the image.

5. Left-click on the Tank_Out in the library and drag and drop it on to the
image. The Define Instance Link dialog is displayed, as shown above.
In the Instance Name field enter Output and click OK.

6. Left-click on the truck in the library and drag and drop it on to the
image. The Instance Parameters dialog is displayed.

 

7. In the Instance Name field enter Truck and click OK.

8. Click Exit to close the clusters library.

Your image should now look like this:
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Repositioning the Objects Inserted from the Clusters Library

You will now reposition the reactor, the output tank and the truck so that
the image resembles the image of the Final Application. You may want to
look at the picture of the Final Application on page 13 to remind you of
the object’s position.

! To reposition an object:

1. Click on an object to select it.

2. Click again and drag it to its new position.

You will now draw in the piping using Wizcon for Internet drawing
tools.
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W izcon for Internet Drawing Tools

In this section you will draw the piping on the image using Wizcon for
Internet drawing tools. This involves the following steps:

 Preparing the environment for drawing by displaying additional Wizcon
for Internet Image Editor toolboxes, as described below.

 Selecting colors for the piping, as described on the following page.

 Drawing the piping in sections, starting at the storage tank and ending
at the truck, as described on page 45.

The W izcon for Internet Editor Toolboxes

The Wizcon for Internet Image Editor features many different toolboxes to
enable you to build your application. In this tutorial we shall use three of
them: the Drawings toolbox which opened automatically when you opened
the image, the Objects toolbox which you will open in Step 7, Creating
Trigger Buttons, and the Colors toolbox which you will open now, if it is
not already open.

! To display toolboxes:

From the View menu of the image, select Colors to display the Colors
toolbox. The toolbox is displayed on the image.

If a toolbox covers an object, you may want to reposition it by
holding down the left mouse button on its title bar and dragging it to
a different position.

Selecting Colors for the Piping

In this step you will select the colors of the piping from the Colors toolbox;
red piping with a black outline.
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! To select colors from the toolbox:

From the Colors toolbox click on black and right-click on red.

Drawing the Piping

You will draw the piping in sections starting from the storage base of the
storage tank and ending at the truck.

You will draw each section of pipe from one point to another, as described
below.

 Click once at the starting point and move the cursor to draw the pipe.

 Click again to move the cursor in another direction or if you have
reached the end point of pipe.

 Right-click.

! To draw piping:

1. Select the Orthogonal Pipe  tool from the Drawings toolbox.

2. Click the base of the storage tank and slowly move the cursor down to
the inlet of the pump. Click, then right-click. Notice the pipe.

3. Click the outlet of the pump and move the cursor to the inlet of the
Valve_In. Click, then right-click.

4. Click the outlet of the Valve_In and move the cursor to the reactor.
Click, then right-click.

5. Click the base of the reactor and move the cursor down until it is in line
with the Valve_Out inlet. Click and move the cursor diagonally across
until it reaches the inlet of the Valve_Out. Click, then right-click.

6. Click the outlet of the Valve_Out and move the cursor across until it
reaches the left side of the Tank_Out. Click, then right-click.
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7. Click the right side of the Tank_Out and move the cursor diagonally
across the image until it is in line with the inlet of the truck.

 Click, then move the cursor down until it reaches the inlet of the truck.
Click, then right-click.

8. Right-click anywhere on the image to deselect the Orthogonal Pipe
tool. Your image should now resemble the image displayed on page 13.

Use the Repaint tool to clean up (refresh) your image by selecting
Repaint from the Options menu or by holding down the Alt key and
pressing R.

Did You Know
 Wizcon for Internet comes with 300 standard cluster objects.

 New Wizcon for Internet clusters can be defined with standard
Wizcon graphical tools and require no programming skills.

 Wizcon for Internet images are based on vector graphics that
allow multi-step zooming.

 Vector graphics enable an entire process to be drawn in one
image. Zones can then be defined to display different scales of
parts of the same image.

In the next step you will add the dynamic text displays for the
reactor and the Valve_Out.
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Step 4: Creating Dynamic Text Displays

A dynamic text display is one that has been defined to change according to
the varying value of the tags with which it has been associated. For
example, the reading of the dynamic text display next to the storage tank
will reflect the level of material in the storage tank as it fills and empties.

In this step you will create dynamic text displays that will reflect the
following:

 The level of material in the reactor, as described below.

 The open/close status of the Valve_Out, as described on page 49.

Creating a Dynamic Text Display for the Reactor

You will now create a blue text display in a yellow text box to represent the
level of the material in the reactor. This involves:

 Inserting a yellow text box from the clusters library.

 Changing the font to black and its background color to yellow.

 Determining the display.

! To create a dynamic text display for the reactor:

1. From the Clusters menu of the image, select Open lib to display the
Drag&Drop to Img dialog. Click on the drop-down box in the dialog,
and select FIRSTLIB.

2. Hold down the left mouse button on the Dig_Sc_Yellow object in the
clusters library and drag and drop it on the image. Enter an instance
name of Box and click OK.

3. Click Exit to close the clusters library window.
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4. Click on the box to select it, then click again and drag it to its position
on the right hand side of the reactor.

5. In the Colors toolbox, click black to determine the color of the font and
then right-click yellow to determine the background color of the font.

6. From the Drawings toolbox, select the Text  tool and click inside
the box. The Text dialog is displayed:

 

7. Click Tag Value. The Tag Value dialog is displayed in which you will
select a tag to be associated with the text display.

 

8. Click on the arrow to the right of the Tag field and select
REACTOR_LEVEL from the drop-down list.

9. In the Display Mode area, make sure that DEC is selected.
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10. In the Options, deselect + Prefixed, then deselect Leading Zeros. In
the Display Format area enter 4 in the Digits Before field and 0 in the
After field. The dialog is displayed as below:

 

11. Click OK to save your definitions and to close the dialog. The text
display appears in the Tag Value button.

If you need to center the text display in the text box, click on the
Select  tool in the Drawings toolbox, then click on the text to
select it. Click again and drag the text into position.

Creating a Dynamic Text Display for the Valve_Out

You will now create a yellow text display in a blue text box to display the
status of the Valve_Out; when the valve is open the display will read
OPEN, and when it is closed the display will read CLOSED. This
involves:

 Inserting a blue text box from the clusters library.

 Changing the font to yellow and its background color to blue.

 Opening a pre-defined file that contains the information necessary to
create Open/Close buttons.
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! To define a text display for the Valve_Out:

1. Drag and drop the object Dig_Sc_Blue from the clusters library as
described on page 41. Enter an instance name of Box2, click OK and
close the library.

2. Click on the box to select it, then click again and drag it to its position
above Valve_Out.

3. In the Color toolbox, click yellow to determine the color of the font,
then right-click blue to determine the background color of the font.

4. From the Drawings toolbox, select the Text  tool and click on the
box. The Text dialog is displayed. In this dialog you will define the text
object type for the tag value.

 

5. Click Text Table. The Open Text Table File dialog is displayed.
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6. Select Openclos and click OK. The Text Table dialog is displayed in
which pre-defined Open/Close settings appear:

 

7. Click on the arrow to the right of the Tag field and select
VALVE_OUT_POS from the drop-down list.

8. Click Save to save your definitions and to close the dialog. The text
display appears in the Tag Value button.

Save your file by selecting Save from the File menu.

In the next step you will define dynamics for the truck.
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Step 5: Making an Object Dynamic

Dynamic objects are elements that are related to tags. When their tag value
changes, the visual properties of the object such as position and color,
change accordingly. In order to implement object animation, tag value
ranges are denoted by start and end values.

Most of the objects in the final image are dynamic. They have the following
dynamic behavior:

 The button on the pump changes color when clicked indicating that
the pump is open or closed.

 The handle on the Valve_In changes color when clicked and swivels
from right to left and vice-versa, indicating that the valve is open or
closed.

 The handle on the Valve_Out changes color when clicked, indicating
that the pump is open or closed.

 The storage tank fills.

 The reactor empties.

 The output tank fills and empties.

 The truck moves.

In this Exercise Application, the dynamics for all objects except for the
truck, have been prepared for you in order to shorten the process of this
tutorial. In this section you will make the truck dynamic so that it will move
from one side of the image to the other when it has filled with material.

You inserted the truck into the image in the previous step. The truck was
inserted from the clusters library with its pre-defined behavior patterns. In
order to make a change to its attributes, such as making it dynamic, it first
has to be broken (disconnected), from the clusters library.
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This section involves the following steps:

 Breaking the truck from the clusters library, as described below.

 Defining the truck’s dynamics, as described below.

Breaking the Truck from the Clusters Library

In order to edit the truck independently of the clusters library and its other
instances, it needs to be broken (disconnected) from the clusters library, as
described below. Afterwards you will define its dynamics.

! To break the truck from the clusters library:

1. Click on the truck to select it.

2. Right-click on the truck and select Break Cluster. The truck is now
disconnected from the clusters library.

Defining Dynamics for the Truck

In the final application the truck moved from one side of the image to the
other, and back. You will now define dynamics (animation) for the truck in
this unfinished application so that it will do the same. Later, you will
simulate the application to see if the dynamics work.

Dynamics are defined in the Dynamic Parameters dialog displayed on the
following page, in which you can define one or more dynamics for one or
more objects at the same time.
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Wizcon for Internet also enables you to define dynamics of different types
for a single object. These types are listed in the Animation area of the
dialog. For example, Fill, in which an object fills like the reactor in the
complete application, or Move 1, in which an object moves.

Each animation type has a row of fields to its left in which you enter the
required data for the dynamic.

The Animation area which
lists the animation types

The To field in which
you enter an end value

for the dynamic

The From field in which
you enter a start value

for the dynamic

The Tag  field in which
you click the arrow and
select a tag from the

drop-down list
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In this application you will define one dynamic for the truck to enable it to
move from one side of the image to the other, and back.

! To define the truck’s dynamics:

1. Right-click on the truck and select Dynamic Definition. The Dynamic
Parameters dialog is displayed:

 

Move 1 row: Enter data
in the fields to the left of
this row to define a move

dynamic for the truck

 Since you want the truck to move, fill in the fields to the left of the
Move 1 row which is a field in the list of Animation types.

2. In the Move 1 row of the Animation types, click on the arrow to the
right of the Tags field and select MOVE_TRUCK from the drop-down
list.

3. In the From field enter 1. This is the starting point of the truck.

4. In the To field enter 100. This signifies the trucks destination point.

5. Click Move 1. The dialog closes and the icon changes to a
bi-directional arrow.
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6. Click on the truck to determine its starting point. This now represents
the position value 1.

7. Move the cursor in a straight line to the end of the screen, notice that a
diagram of the truck trails the cursor. When you have reached the end
of the screen, click to determine the end point. This now represents the
position value 100. The Dynamic Parameters dialog reopens.

8. Click OK to close the dialog.

9. From the image File menu, select Save to save your changes.

Simulating the Dynamics

After defining dynamics for an object, you can simulate the application and
test it.

! To simulate dynamics:

1. From the Options menu in the image, select Simulate. The Simulate
Tag Values dialog opens:

 

2. Click on the arrow to the right of the Tag field and select
MOVE_TRUCK from the drop-down list.
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3. In the New Suggested Value field, enter 100 and click Apply to move
the truck to its determined end point.

 Re-position the truck to its starting point by opening the dialog as
described in step 1 and entering a value of 0 in the New Suggested
Value field and clicking Apply.

 or,

Move the scroll bar underneath the Tag field from one end of the dialog
to the other. Notice how the truck moves. Reposition the truck to its
starting position and click Exit.

This simulation does not really change the tag value. If you need to

make changes to the tag you can use the Add Tag  button in the
Quick Access bar.

In the next step you will define two zones for the image.
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Step 6: Defining Zones

A zone is an area of an image that can be viewed in close up. Each image
can consist of many zones, each representing a different part of a plant.
Each zone is displayed in the entire image window without scrolling. When
an image is saved, a picture file is created for each zone. This picture file is
what is actually displayed by the Picture Viewer in your web page.

In this step you will define the following:

 A zone called Overview that will display the entire image, as
described below.

 A zone called Input that will display the part of the image that deals
with the input process of the plant, as described on page 61.

Defining the Overview Zone

You have already positioned the image so that it is clearly displayed on
your desktop. You will now define this position as the Overview zone. This
is the zone in which the image is displayed in the browser.

Defining a zone is a three stage process:

 Marking the area of the zone, as described on the following page.

 Zooming to the marked area, as described on page 60.

 Defining the zoomed area as a zone, as described on page 60.
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Marking the Area of the Zone

Using the Wizcon for Internet zoom tool you will now mark off the
perimeter of the image as shown below.

! To mark an area:

1. From the Options menu in the image, select Window. The cursor

changes to a .

2. Place the cursor to right of the truck, as shown below:

 
Place cursor here

3. Click and move the cursor upwards. Notice how the area is marked with
a rectangle. After you have marked the input area of the image click
again to stop marking.
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Zooming to a Marked Area

Now that you have marked off the area that will become the zone, click
anywhere inside the rectangle to zoom and view this area so that you can
define this area as a new zone.

Defining the Area as a Zone

You will now define this area as a zone called Overview.

! To define an area as a zone:

1. From the Options menu select Zones Definition. The Zones Definition
dialog is displayed.

 

2. In the Name field, enter Overview and click Add. The zone has been
added to the list of zones in the image.

3. Click Save to save your definitions in the dialog. When you save your
image an additional picture file is created for this zone.

Now you will define the Input zone.
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Defining the Input Zone

In this section you will define the Input zone that includes the part of the
image that deals with the input process. This is similar to defining the
Overview zone.

! To define the Input zone:

1. Mark the area of the zone, as shown below:

 

•  From the Options menu in the image, select Window. The cursor

changes to a .

•  Place the cursor to right of the Valve_Out, as shown below:

 
Place cursor here

•  Click and move the cursor upwards to mark off the area. After you
have marked the input area, click again to stop marking.
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2. Zoom to the marked area:

Click anywhere inside the rectangle to zoom and view this area so that
you can define it as a new zone.

3. Define the area as the Input zone:

•  From the Options menu select Zones Definition. The Zones
Definition dialog is displayed.

•  In the Name field, enter INPUT and click Add. The zone has been
added to the list of zones in the image. The dialog now appears as
shown below:

 

•  Click Save to save your definitions in the dialog. When you save
your image a picture file is created for this zone.
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Did You Know
 The Wizcon for Internet Image Editor enables you to have up to

64 layers in one image.

 The Wizcon for Internet Image Editor enables you to have up to
500 zones in one image.

 The Wizcon for Internet Image Editor enables you to have up to
2048 zooming scales.

In the next step you will create two clickable buttons: one in the
Input zone of the image that can be clicked to display the entire
image (the Overview zone) and one in the Overview zone that can be
clicked to display the Input zone.
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Step 7: Creating Trigger Buttons

A trigger can be any object in an image that has been defined to execute a
specific operation whenever it is selected. For example, when you click on
a trigger object you may initiate a predefined tag or go to a zone.

Wizcon for Internet has the following tag input methods that can be used
for trigger objects: Action, Buttons, Bit, Data Entry, Momentary, and
Smooth. You will use the Action tag input method.

In the previous step you created two zones for the image: the Overview
zone and the Input zone. The image is currently displayed in this zone,
meaning that only the part of the image that represents the input process is
displayed.

In this step you will create two trigger buttons that will be displayed side by
side and will be viewable in both zones:

 One to display the entire image, the Overview zone, as described on
the following page.

 One to display the part of the image that represents the input
process, the Input zone, as described on page 68.

After you have created the buttons you will save and close the image, as
described on page 69.

Note: Wizcon for Internet also enables you to define objects and
information visible in specific layers of the image and not in others. Refer
to the Wizcon for Internet User’s Guide for more details about this feature.
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Creating a Trigger Button to Display the Entire
Image (the Overview Zone)

You will now create a trigger button that when clicked will display the
entire image. This involves the following steps:

 Inserting a button from the clusters library and positioning it, as
described below.

 Creating a text display that will read Overview Zone, as described
on page 66.

 Defining a trigger for the button, as described on page 66.

Inserting a Button

You will now insert a gray button from the clusters menu and position it in
the bottom left corner of the image. You may want to refer to the image of
the Final Application shown at the beginning of this Getting Started guide
on page 13.

! To insert and position a button:

1. Drag and drop the object Button_menu from the clusters library as
described on page 47. Enter the instance name Box2 and click OK.

2. Click Exit to close the clusters library.

3. Click on the button to select it, then click it again and drag it to the
bottom left hand side of the image.
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Creating a Text Display

Now you will create a black text display with a white background for the
button that will read Overview Zone. This will be positioned above the
button.

! To create a text display:

1. In the Colors toolbox, click black and right-click white to specify the
color of the font and its background.

2. Select the Text  tool from the Drawings toolbox and click on the
image above the button. The Text dialog is displayed:

 

3. In the Text field enter Overview Zone and click OK to save your
definitions. The text is now displayed on the image above the button.

You may want to reposition the text by clicking the text to select it,
then clicking again and dragging it into place.

Defining a Trigger for the Button

Now you will define a trigger for the button so that when the button is
clicked the entire image will be displayed. You will first need to open the
Objects toolbox.
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! To define a trigger:

1. From the View menu, select Objects. The Objects toolbox is displayed.

2. Click on the button to select it and then select the Trigger Definition
 tool from the Objects toolbox as shown below:

 

Trigger Definition tool

 The Trigger Object Definition dialog is displayed:

 

3. Click Action to display the Action Definition dialog in which you will
select the zone.

 

4. Click the arrow to the right of the Zone field and select OVERVIEW
from the drop-down list. This is the zone that will be displayed when
the button is clicked.
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5. Click OK to close the dialog.

6. Click the Test button in the Trigger Object Definition dialog to test the
trigger. The entire image is now displayed.

7. Click OK to save your definitions and to close the dialog.

Creating a Trigger Button to Display the Input
Process (the Input Zone)

The image is now displayed in the Overview zone. You will now create a
trigger button that when clicked will display the Input zone, and a text
display that will read Input Zone. This is similar to the trigger button you
have just created for the Overview zone.

! To create a trigger button:

1. Insert a button from the clusters library, as described on page 46.

Click on the button to select it, then click it again and drag it to the
bottom left hand side of the image. Align the button with the first
button you inserted previously, as shown below:

2. Create a text display

•  Select the Text  tool from the Drawings toolbox and click on the
image just above the button. The Text dialog is displayed, as shown
on page 66.

•  In the Text field enter Input Zone and click OK to save your
definitions. The text is now displayed just above the button.
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3. Define a trigger:

•  Click on the button to select it and then select the Trigger
Definition  tool from the Objects toolbox. The Trigger Object
Definition dialog is displayed.

•  Click Action to display the Action Definition dialog in which you
will select the zone.

•  Click the arrow to the right of the Zone field and select INPUT
from the drop-down list. This is the zone that will be displayed
when the button is clicked.

•  Click OK to close the dialog.

•  Click the Test button in the Trigger Object Definition dialog to test
the trigger. The Input zone is displayed.

•  Click OK to save your definitions and to close the dialog.

Saving and Closing the Image

You have completed the application image. You will now save and close
the image.

! To save and close the image:

1. If you used a grid, remove it by deselecting Grid Show from the Modes
menu.

2. From the File menu, select Save.

3. From the File menu, select Exit. The image closes.

 In the next step you will generate an HTML file for the image.
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Step 8: Generating HTML Files

In this Exercise Application (Tutor Exercise), you will use the Wizcon
for Internet HTML Assistant to generate two HTML files: one that contains
a Picture Viewer to display a graphical representation of the process, as
shown on page 13, and one that contains an Events Summary Viewer to
display online alarms, as shown on page 17.

The Wizcon for Internet HTML Assistant also enables you to generate a
single HTML file containing both a Picture Viewer and an Events Summary
Viewer.

After you have generated HTML files you will edit them. When we
describe editing an HTML file, we have provided instructions for using the
Netscape HTML editor. If you are using a different HTML editor, we
recommend viewing its User’s Guide or on-line help.

In this step we will describe how to generate an HTML file containing a
Picture Viewer. In Step 9, you will create an Events Summary Profile and
then generate an HTML file containing an Events Summary Viewer in Step
10.
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Generating an HTML File Containing a Picture
Viewer

The Wizcon for Internet HTML Assistant enables you to choose the picture
displayed by the Picture Viewer in the browser, by selecting one of the
project picture files. Two picture files were automatically generated in the
previous step: one of the Overview zone and one of the Input zone. In this
section you will generate an HTML file for the picture created when you
defined the Overview zone, in Step 6: MY_FIRST.wnp. Then you will
view the file in your HTML editor and add a title that will read: My First
Plant Floor View.

When you generate an HTML file, you first open a new file and name it.
This is the file that you will access later through the Wizcon for Internet
welcome page you viewed on page 11. Therefore, it is important that you
name the file MyFirst.htm, as described below.

! To generate an HTML file:

1. From the All Containers section of the Wizcon Application Studio,
right-click HTML and select New HTML File from the pop up menu.
or,
Click the New HTML file  icon in the toolbar. The Generate New
HTML File dialog is displayed:
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2. Select Include Picture Viewer, in the top left hand corner of the
dialog.

 Let’s look at the Picture field: It displays a drop-down list of .wnp
pictures. A single .wnp picture is created for every zone defined in the
image. MY_FIRST.wnp is currently displayed in the field. This is the
zone that was active when you last saved the image.

3. Click on the arrow on the right side of the field. A list of the pictures
contained in this application is displayed. Select
MY_FIRST_OVERVIEW.wnp. This is the picture that will be
displayed by the Picture Viewer in your browser when the HTML file
is first opened.

4. Click the Generate button. The dialog closes and the New File dialog
is displayed.
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 In the File name field enter MyFirst.htm. Click Save.

5. To add a title: right-click the required HTML file and select Edit
HTML file from the popup menu. The file is opened in your default
HTML editor.

•  At the top of the file enter My First Plant Floor View.

•  Add a line to separate the title from the HTML code by clicking the
Insert Horiz. Line  button in the Character Format toolbar.

6. From the browser File menu, select Save to save your changes.

7. From the browser File menu, select Exit to close the browser. The
Application Studio is clearly displayed. Notice that MyFirst.htm now
appears in the List of HTML files.

If the file does not open automatically, you can open it through
Notepad:
1. Click on the Start button on your desktop, point to Programs,

then point to Accessories and select Notepad. Notepad is
opened.

2. From the File menu, select Open and browse to
C:\WizFactory\Wiscon\Web\GettingStartedTutor\Docs\MyFirst.htm.
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We recommend defining Notepad as your default HTML editor as
described on page 91. In this way the HTML file will open
automatically.

In the next step you will define an Events Summary Profile.
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Step 9: Events Summary Profiles

The Events Summary Profile contains the definitions that determine the
way alarms are displayed in the Events Summary. Alarms are displayed
based on the following parameters:

•  Start Time: the date and time the alarm was generated

•  Ack Time: the time the alarm was acknowledged by the operator

•  End Time: the time the alarm was terminated

•  Severity: the severity of the alarm

•  Text: the alarm message

•  Zone: the area of the plant in which the alarm occurred

•  Family: the name assigned to a specified group of alarms

•  Ack ID: The identity of the operator who acknowledged the alarm
(not in use)

•  Station Name: the station in which the alarm is displayed

Defining an Events Summary

The Events Summary displays by default the Start Time, Ack Time, End
Time and Severity of alarms. You will now create an Events Summary that
in addition to these default parameters will display the Zone of an alarm.

! To define an Events Summary:

1. From the All Containers section of the Wizcon Application Studio,
right-click Events Summary Profiles and select New Profile. The
Wizcon Events Summary Profile dialog is displayed.
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2. Select the Display tab. The dialog is displayed as below:

 

 The alarm information is displayed in four columns:

Column: Displays the range of parameters by which the alarm can be
displayed.

View: Specifies whether the parameter will be displayed in the Events
Summary. This is indicated by a plus sign in the parameter’s row.

Order: Displays the alarm parameters in ascending or descending order.

Weight: Displays the proportional size of each display column.

3. In the Column area, click on Zone to select it. The entire row is
highlighted.

4. In the View column, double-click in the highlighted row. A plus sign
appears in the row indicating that the Zone parameter will be displayed
in the Events Summary.
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5. In the Order column, double-click Ascending to change the display to
Descending. The alarm information in the Zone parameter will be
displayed in descending order.

6. Click OK. The standard Windows Save As dialog opens.

7. Enter Annun in the File name field and click Save. The Events
Summary appears in the List of Events Summary Profiles in the
Application Studio.

In the next step you will generate an HTML file containing an Events
Summary.
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Step 10: Generating an HTML File w ith the 
Events Summary

In this step you will use the Wizcon for Internet HTML Assistant to
generate an HTML file containing an Events Summary according to the
definitions that you defined for the Events Summary Profile that you
created in the previous step. The resulting HTML page features real-time
monitoring of alarms, as shown below. An operator can then filter the
alarms, and change the way they are viewed. For example in ascending or
descending order.

First you will generate the HTML file and then you will edit it. When we
describe editing an HTML file, we have provided instructions for using the
Netscape HTML editor. If you are using a different HTML editor, we
recommend viewing its User’s Guide or on-line help.

After you have generated the HTML page, you will save the application.
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Generating an HTML file

You will now generate an HTML file that will display the Events Summary
so that you can view active alarms and acknowledge them through your
browser. Then you will edit the file and add a title to it that will read:
Online Alarms.

When you generate an HTML file, you first open a new file and name it.
This is the file that you will access later through the Wizcon for Internet
welcome page, you viewed on page 12. Therefore, it is important that you
name the file FirstAnn.htm, as described below.

! To generate an HTML file with the Events Summary:

1. From the All Containers section of the Application Studio, right-click
HTML and select New HTML File from the pop up menu.
Or

Click the New Events Summary  icon in the Wizcon Application
Studio toolbar. The Generate New HTML File dialog is displayed:

 

Events Summary
Profile created in
the previous step
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2. Select Events Summary, on the left side of the dialog.

 The Events Summary Profile you created in the previous step appears
in the Events Summary Profile field. The size of the HTML page as it
appears in your browser is determined in the Width and Height fields.

3. Leave all options as they are and click the Generate button. The dialog
closes. The dialog closes and the New File dialog is displayed.

 

4. In the File name field enter FirstAnn.htm and click Save.
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5. To add a title: right-click the required HTML file and select Edit
HTML file from the popup menu. The file is opened in your default
HTML editor.

•  At the top of the file enter Online Alarms.

•  Add a line to separate the title from the HTML code by clicking the
Insert Horiz. Line  button in the Character Format toolbar.

6. From the browser File menu, select Save to save your changes.

7. From the browser File menu, select Exit to close the browser. The
Application Studio is clearly displayed. Notice that FirstAnn.htm now
appears in the List of HTML files.

If the file does not open automatically, you can open it through
Notepad, as explained on page 91.

For more details on generating HTML files, refer to page 69.
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Saving Your Application

The Wizcon for Internet application is saved from the Wizcon for Internet
Application Studio.

! To save the Exercise Application:

From the Application Studio File menu, select Save to save your
application.

Now you will launch the application in your browser and test it.
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Step 11: Testing Your Application in a Local 
Browser

After following steps 1 through 10, you have created an application that
replicates the Final Application we described at the beginning of this
guide. Follow the steps below to save your application so that you can test
it in a local browser.

! To test with the application:

1. In the All Containers section, click HTML. A list of HTML files is
displayed.

2. Double-click on Welcome.htm to launch the image in your browser.

3. Now, refer to pages 11 through 18 to so that you can interact with the
application.

When you have finished interacting with your application, refer to
the next step in which you will publish your Wizcon for Internet
application on the Internet or on your Intranet. If do not want to
publish your application, refer to Step 13 in which you will exit
Wizcon for Internet.
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Step 12: Publishing Your Application

You have created a Wizcon for Internet application that can be published so
that other users can interact with the application through the Internet or
through your Intranet.

To publish an application you will need the following installed on a single
computer:

 Windows NT 4.0.

 Java-enabled Browser.

 Wizcon for Internet and the Exercise Application.

 A Web server. For example the Netscape FastTrack Server 2.1 that
can be downloaded from the Netscape Web site at
http://www.netscape.com).

You will also need to know the TCP/IP address of the Web server
computer. Refer to page 94, for details on how to locate a TCP/IP address.

This step involves the following:

 Publishing the Exercise Application, as described on the following
page.

 Interacting with the application through a browser.
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Publishing the Exercise Application

You can now publish the Exercise Application. Afterward you will
interact with the application.

To enable you to interact with your application, the web application must
be mapped to a web server, this operation is also called publish. The web
server enables you or any web browser user to view your application by
connecting to your site.

! To publish the Exercise Application:

1. Map the Wizcon for Internet web application directory as the primary
directory of your web server.

2. Install a Web Server such as the Microsoft Internet Information Server,
or the Netscape FastTrack.

3. Add an additional document directory to your web server and map it to
your web application directory of your application.
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The Netscape FastTrack Server provides the Netscape Server
Administration tool application for publishing, as shown below:

➤ To publish your web application with the Netscape FastTrack web
server:

1. Select Content Management in the menu bar and then Additional
Document Directories.

2. Enter the URL prefix of the site application in the URL Prefix field.

3. Enter the physical directory of your web application in the Map To
Directory field. This is the Docs directory under your application
directory. For example: c:\wizcon for internet\demo\docs.
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Using Microsoft Internet Information Server 4.0

The Microsoft Internet Information Server provides the Personal Web
Manager for publishing, as shown below:

! To publish your web application with Microsoft Internet Information
Service:

1. Map the physical directory of your application docs to a virtual
directory (the URL).

2. Invoke your Personal Web Manager and select Advanced Options.
The Virtual Directories tree appears.

3. Select the folder under which you want to place your application.

4. Connect to the Web Server and check your application. Use the folder
you specified to access the web application.

For further information refer to the Windows NT Option Pack
Documentation - Microsoft Internet Explorer, Personal Web Manager's
online help: Adding New Publishing Directories.
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Interacting w ith the Exercise Application

You have published your application. Now you can interact with it from
another computer through the Internet or your Intranet, depending on your
web server security settings and your network configuration.

Now you are going to launch your web browser and enter an address made
of your TCP/IP address and the welcome page file name (welcome.htm). If
you do not know the TCP/IP address of the web server computer, refer to
page 94 for details about how to locate a TCP/IP address.

Note that in order to interact with your application:

 Your Web server must be running.

 Wizcon for Internet must be running on the server computer.



Getting Started  89

! To interact with the application:

1. Launch your browser.

2. In the Go to field, enter your TCP/IP address followed by
/welcome.htm, the name of the welcome page file, and press Enter.
For example, http://194.90.186.52/welcome.htm.

The welcome page is displayed in your browser, as shown below.

Now, you can click on the Go to Plant Floor View link to display the
graphical representation of the plant process. Refer to pages 11 through
18 to see how to interact with the plant process.

Click on the Go to Online Alarms View link to display the Events
Summary in which you can view the alarms encountered when running
the application.

Now you can exit the application.
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Step 13: Exiting W izcon for Internet

Now that you have finished working with your application, you can exit
Wizcon for Internet.

! To exit Wizcon for Internet:

1. From the browser File menu, select Exit. The browser closes and the
Quick Access bar is displayed.

2. Click on the Close  button in its top right corner. Wizcon for Internet
closes.

Congratulations on completing your tutorial lesson! You are now
familiar with the following procedures involved in creating an
application:

 Defining a tag.

 Defining an alarm.

 Building an image by inserting objects from the clusters library, and
using Wizcon for Internet drawing tools.

 Creating dynamic text displays.

 Defining dynamics to make an object move.

 Defining zones.

 Creating trigger buttons.

 Creating an Events Summary Profile to display alarms.

 Generating HTML files: one to display a graphical representation of
the application, and one to display online alarms.

 Publishing an application on a Web server.
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Appendix A: Defining Notepad as Your Default 
HTML Editor

If your HTML editor does not open automatically, you can define Notepad
as your default HTML editor so that it will automatically open after you
generate an HTML file.

! To define Notepad as your default HTML editor:

1. Right-click the Start button on your desktop and select Explore. The
Windows Explorer opens.

2. From the View menu, select Options. The Options dialog is displayed.

3. Select the File Types tab to display the following page:
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4. In the Registered file types list, select Netscape Hypertext Document
if Netscape is your default browser or Internet Document if Microsoft
Explorer is your default browser.

5. Click the Edit button. The Edit File Type dialog is displayed:

 

 If Edit appears in the Actions list continue with step 11 on the
following page, if Edit does not appear in the Actions list continue
with the next step.

6. Click the New button. The New Action dialog is displayed. In the
Action field enter Edit.
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7. Click the Browse button and browse to notepad.exe (to be found in the
directory in which you installed Windows). Click Open. The path
appears in the Application used to perform action field, as shown
below:

 

8. Make sure that the Use DDE option is not selected.

9. Click OK to save your definitions and to close the dialog.

10. Click Close to close the Edit File Type dialog. Notepad is now your
default HTML editor.

11. If Edit appears in the Actions field:

•  Click the Edit button. The Editing action for type: dialog is
displayed.

 In the Application used to perform action field, check that
Notepad and its location is displayed in the field, as shown above.
If Notepad does not appear in the field, refer to steps 6 through 10
to configure Notepad as your default HTML editor.

•  If Notepad appears in the field, click Cancel to close the dialog and
then Close to close the Edit File Type dialog.
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Appendix B: Locating Your TCP/IP Address

If you do not know the TCP/IP address of the web server computer, you can
locate it through the Network Neighborhood icon on your desktop.

! To locate a TCP/IP Address:

1. Right-click on the Network Neighborhood icon on your desktop.
Select Properties from the drop-down menu. The Network dialog is
displayed:
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2. Select TCP/IP and click the Properties button to display the TCP/IP
properties. The following dialog is displayed:

 

3. Your IP address is displayed in the IP Address field. Make a note of
the address and click Cancel to close the dialog.
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